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Sicherheitshinweise Lesen Sie dieses Handbuch sorgfältig, damit Sie das Gerät
richtig bedienen und umfassend nutzen können und um
Verletzungen oder andere Gefahren zu vermeiden.

Verwendung des Geräts

Unsachgemäße Verwendung kann zu Explosionen,
Bränden oder elektrischen Schlägen führen.

Vermeiden von Hörschäden

Versuchen Sie nicht, das
Gerät selbstständig zu 
zerlegen, zu reparieren oder
zu modifizieren.

Achten Sie darauf, dass
das Gerät nicht mit Wasser
in Berührung kommt.
Sollte das Gerät mit Wasser in
Berührung kommen, schalten
Sie es nicht ein. Wenden Sie
sich in diesem Fall an den
Kundendienst von Samsung.

Bewahren Sie das Gerät nicht
in feuchter, staubiger oder
rußiger Umgebung auf. 
Dies kann zu Bränden oder
elektrischen Schlägen führen.

Vermeiden von Verkehrsunfällen

Während des Auto-, Motorrad- oder Fahrradfahrens
niemals Ohr- oder Kopfhörer verwenden.
Dies kann zu schweren Unfällen führen und ist darüber 
hinaus in manchen Ländern gesetzlich verboten.
Die Verwendung von Ohr- oder Kopfhörern unterwegs,
speziell beim Überqueren der Fahrbahn, kann ebenfalls zu
schweren Unfällen führen.

Achten Sie in Ihrem eigenen Interesse darauf, dass
sich das Ohr- bzw. Kopfhörerkabel weder beim
Sporttraining noch beim Laufen an Ihrem Arm oder an
umstehenden Objekten verfängt.

Setzen Sie das Gerät 
keinesfalls Temperaturen über
35 °C aus (wie z. B. in einer
Sauna oder im Innenraum
eines geparkten Fahrzeugs).
Im Sommer können die
Temperaturen in einem Fahrzeug
auf bis zu 80 °C ansteigen.

Die Nichtbeachtung dieser Anweisungen kann zu ernsthaften
Verletzungen führen.WARNUNG

Die Verwendung von Ohr- oder Kopfhörern über
einen längeren Zeitraum kann zu erstzunehmenden
Hörschäden führen.
Wenn Sie über einen längeren Zeitraum einem Geräuschpegel
über 85 dB ausgesetzt sind, kann Ihr Hörvermögen negativ
beeinträchtigt werden.
Je lauter der Geräuschpegel, desto schwerwiegender ist der
Hörschaden (eine normale Unterhaltung hat einen Geräuschpegel
von 50 bis 60 dB, Straßenlärm erreicht etwa 80 dB).
Wir raten ausdrücklich, den Lautstärkeregler auf die mittlere
Stufe zu stellen (die mittlere Lautstärke beträgt üblicherweise
weniger als 2/3 des Maximums).

Wenn Sie ein Klingeln im Ohr wahrnehmen, sollten
Sie die Lautstärke senken oder vorübergehend auf die
Verwendung von Ohr- oder Kopfhörern verzichten.
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Verwendung des Geräts

Sicherung wichtiger Daten Vermeiden von Fehlfunktionen

Fertigen Sie immer
Sicherheitskopien wichtiger
Daten an.
Beachten Sie bitte, dass Samsung
keine Verantwortung für
Datenverluste übernimmt, die auf
Schäden bzw. Reparaturen am
Gerät oder auf andere Ursachen
zurückzuführen sind.

Vermeiden von Fehlfunktionen

Die Nichtbeachtung dieser Anweisungen kann zu Verletzungen oder zu
Beschädigungen des Geräts führen.

Vermeiden Sie übermäßige
Krafteinwirkungen auf das
Gerät. Lassen Sie es nicht
fallen. Stellen Sie keine
schweren Objekte auf das
Gerät.

Stellen Sie sicher, dass
weder Staub noch
Fremdkörper in das Gerät
eindringen können.

Verwenden Sie nur von
Samsung hergestelltes oder
zugelassenes Zubehör.

Sprühen Sie kein Wasser auf
das Gerät. Reinigen Sie das
Gerät keinesfalls mit
Chemikalien wie Benzol oder
mit Lösungsmitteln, da dies
zu Bränden, elektrischen
Schlägen oder zu einer
Beschädigung der
Oberfläche führen kann.

Stellen Sie das Gerät nicht
in der Nähe magnetischer
Objekte ab, da dies zu
Fehlfunktionen führen kann.

ACHTUNG
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Zubehör überprüfen

Player Ohrhörer USB-Kabel Installations-CD

■ Das Design des Zubehörs kann aufgrund von Weiterentwicklungen ohne vorherige
Ankündigung geändert werden.
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Vorderseite/rechte Seite

Ein/Aus-
Schalter 
und
Sperrschalter

Alle Tasten sind als berührungssensitive Sensortasten ausgeführt, die durch leichtes Antippen bedient
werden.

Display

Zurück-Taste/
Taste für Hauptmenü

Wiedergabe-, Pausen-
und Auswahltaste

Taste für
Optionsmenü

Tasten 
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Unterseite/Rückseite

USB-
Anschluss

Ohrhörer-
buchse

Reset-Taste

Komponenten (Fortsetzung)
Allgemeine Informationen

[Rückseite]
[Unterseite]

Ohrhöreranschluss

√ Unterseite

Ohrhörer
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Displayanzeigen
Allgemeine Informationen

HINWEIS

■   Die Bildschirmfotos dienen nur zur Veranschaulichung. Die tatsächliche Bildschirmanzeige kann von
dieser Abbildung abweichen.

1 Wiedergabemodus

3 Musiktitel

2 Grafischer Equalizer

4 Wiedergabestatus

5 Anzeige für aktuelle
Titelnummer/Gesamttitelanzahl

6 Toneffekt

7 Akkustatus

8 Wiedergabezeit

9 Wiedergabe/Pause

Music (Musik)

Normal

1.Life is cool

002/020 √√ 00:02:20

1

2

3

4
5

6 

7

8

9
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Tastenfunktionen
Allgemeine Informationen

■   Schalter entgegen der Pfeilrichtung schieben und halten: Gerät ein- oder
ausschalten.

■   Schalter in Pfeilrichtung schieben: Tastensperre einschalten.

■   Nach oben, unten, links und rechts gehen; eine Funktion auswählen.
Berühren: Schritt für Schritt nach oben oder unten gehen.

Berühren: Schritt für Schritt nach links oder rechts gehen.
Berühren und halten: Schnell nach oben oder unten gehen.

Berühren: Wiedergabe starten oder Pausenmodus aufrufen; 
zum nächsten Bildschirm gehen.

■   Einen Titel suchen und die Lautstärke regeln, während ein 
Titel abgespielt wird.

Berühren und halten: Eine bestimmte Stelle im aktuellen 
Titel suchen.

Berühren: Zum vorherigen Titel gehen oder den aktuellen Titel von
Anfang an abspielen.

Berühren und halten: Eine bestimmte Stelle im aktuellen 
Titel suchen.

Berühren: Zum nächsten Titel gehen.

Berühren: Lautstärke verringern/erhöhen.

■   Berühren und halten: Hauptmenü öffnen
■   Kurz berühren: Zum vorangegangenen Bildschirm gehen.

Tasten Funktionen

■   Berühren: Optionsmenü öffnen.
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ACHTUNG

■   Berühren Sie die Sensortasten nur mit den Fingerspitzen. Verwenden Sie keine scharfen
Gegenstände, um die Tasten zu bedienen. Sie können sonst beschädigt werden.

■   Bedienen Sie die Sensortasten nur mit sauberen Fingern.

■   Bedienen Sie den Touchscreen nicht mit Handschuhen, da die Tasten dann nicht reagieren.

✽ Mit der Fingerspitze berühren.
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Akku aufladen Laden Sie den Akku vollständig auf, bevor Sie den Player zum ersten 
Mal verwenden bzw. wenn Sie ihn längere Zeit nicht verwendet haben.

Allgemeine Informationen

1 Verbinden Sie das USB-Kabel mit dem
USB-Anschluss (     ) Ihres PCs.

2 Verbinden Sie das andere Ende des USB-
Kabels mit dem USB-Anschluss auf der
Unterseite des Players.
■ Der vollständige Ladevorgang dauert in der

Regel ca. 4 Stunden, kann jedoch je nach PC-
Umgebung variieren.

Akku verwenden

■  Die Umgebungstemperatur beim Aufladen und
Aufbewahren des Akkus sollte zwischen 5°C
und 35°C betragen.

■  Den Akku nicht überladen (höchstens 12 Stunden
aufladen). Übermäßiges Laden oder Entladen kann zu
einer Verkürzung der Lebensdauer des Akkus führen.

■  Die Lebensdauer des Akkus verkürzt sich
allmählich mit dem Gebrauch.

■   Wenn Sie den Player zum Aufladen an ein Notebook angeschlossen haben, überprüfen Sie, ob
der Akku im Notebook vollständig oder zumindest ausreichend geladen ist.HINWEIS
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Grundfunktionen
Allgemeine Informationen

Gerät ein- und ausschalten

Gerät einschalten
Drücken und halten Sie den Schalter [ HOLD √] entgegen der
Pfeilrichtung.
■ Das Gerät wird eingeschaltet.

Gerät ausschalten
Drücken und halten Sie den Schalter [ HOLD √] erneut entgegen
der Pfeilrichtung.
■ Das Gerät wird ausgeschaltet.

■   Das Gerät schaltet sich automatisch ab, wenn im Pausenmodus über einen voreingestellten
Zeitraum keine Tasten betätigt werden (Standardeinstellung: 1 Minute). √ Seite 42HINWEIS

HINWEISE

■   Mit der Taste [ ] gelangen Sie zum vorangegangenen Bildschirm. 

■   Berühren und halten Sie die Taste [ ], um zum Hauptmenü zu gelangen.

Musik wiedergeben

1 Berühren und halten Sie die Taste [ ], um das Hauptmenü
aufzurufen.

2 Wählen Sie mit [ ] die Option <Music> (Musik) aus, und berühren

Sie dann [ ].

■ Das Musikmenü wird geöffnet.

3 Wählen Sie mit [ ] und [ ] die gewünschte Musikdatei aus.

4 Berühren Sie die Taste [ ].
■ Die Musikdatei wird abgespielt

Music

Normal

1.Life is cool

002/020                                                  √√  00:02:20

Normal

1.Life is cool

002/020                                                  √√  00:02:20
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Lautstärke einstellen

Gerätefunktionen sperren

Berühren Sie die Taste [ ].
■   Ein Symbol für die Lautstärkeregelung wird eingeblendet.

■   Berühren Sie die Taste [ ], um die Lautstärke zu erhöhen, oder die Taste
[ ], um sie zu senken.

Mit der Sperrfunktion werden alle Tasten gesperrt. Dies ist beson-
ders sinnvoll beim Laufen oder Joggen, um ein versehentliches
Betätigen von Tasten zu verhindern.

1 Schieben Sie den Schalter [ HOLD √] in Pfeilrichtung.

2 Um die Sperrfunktion wieder aufzuheben, schieben Sie den
Schalter [ HOLD √] entgegen der Pfeilrichtung.

Grundfunktionen (Fortsetzung)
Allgemeine Informationen

Normal

1.Life is cool

002/020                                                  √√ 00:02:20

Normal

1.Life is cool

002/020            √√ 00:02:20
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Falls Fehlfunktionen auftreten, können 
Sie das System zurücksetzen, indem Sie
die Reset-Taste drücken.

Drücken Sie die Reset-Taste auf der
Rückseite des Players mit einem
spitzen Gegenstand, z. B. mit einer
Sicherheitsnadel.
■  Das System wird neu initialisiert.

■  Einstellungen und Dateien im Player wer-
den durch das Rücksetzen nicht beein-
trächtigt.

Reset-Taste

Reset-Taste
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Samsung Media Studio installieren Verwenden Sie Media Studio, um
Musikdateien von Ihrem PC auf
den Player zu übertragen.

Dateien übertragen

Bevor Sie beginnen Legen Sie die mit dem Player mitgelieferte Installations-CD in das 
CD-ROM-Laufwerk Ihres PCs ein.

Falls Media Studio nicht automatisch installiert wird
■   Wenn Sie das Programm auf einem PC unter Windows XP installieren möchten, melden Sie sich zuvor

als Administrator an. Weitere Informationen dazu, wie Sie sich als Administrator anmelden, finden Sie
im Benutzerhandbuch Ihres PCs.

ACHTUNG

1 Klicken Sie auf <Install now> (Jetzt installieren).

2 Klicken Sie auf <NEXT> (Weiter).
■ Die Installation von Media Studio beginnt.

■ Nach Abschluss der Installation wird ein 
Symbol auf dem Desktop erstellt, und Media

Studio wird gestartet.
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An den PC anschließen
Dateien übertragen

Bevor Sie beginnen Verwenden Sie zum Anschließen des Players an den PC das beiliegende 
USB-Kabel.

1

1

Verbinden Sie das USB-Kabel mit dem USB-Anschluss (     ) Ihres PCs.

2

2

Verbinden Sie das andere Ende des USB-Kabels mit dem USB-Anschluss des
Players.

Ihr PC muss folgende Systemanforderungen erfüllen:

■   Pentium 300 MHz oder höher ■   Windows XP Service Pack 2 oder höher
■   DirectX 9.0 oder höher ■   USB 2.0
■   100 MB freier Festplattenspeicher ■   CD-Rom-Laufwerk (2-fach oder höher)
■   Windows Media Player 10.0 oder höher ■   Auflösung 1024 X 768 oder höher

Systemvoraussetzungen

ACHTUNG

■   Wenn Sie den Player über einen USB-Hub anschließen, kann die Verbindung instabil sein. Schließen
Sie den Player stets direkt an den PC an.

■   Wenn Sie den Player an einen PC anschließen, wird automatisch der Ladestatus des Akkus über-
prüft. Bei niedrigem Akkuladestand führt der Player automatisch einen mehrere Minuten dauernden
Ladevorgang durch, bevor die Verbindung zum PC hergestellt wird.
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Dateien/Ordner zu Samsung Media Studio hinzufügen
Dateien übertragen

Unter Hilfe finden Sie weitere Informationen zur Verwendung von Media Studio.
■ Klicken Sie im oberen Bereich von Media Studio auf <MENU> (Menü) ➝ <Help> (Hilfe) ➝ <Help> (Hilfe).

Mit Media Studio können Sie Dateien und Ordner auswählen und verwalten und
diese auf den Player übertragen.

33

2
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1 Media Studio startet automatisch, sobald Sie den Player an den PC anschließen.
■ Fall das Programm nicht automatisch startet, doppelklicken Sie auf das Media Studio-Symbol 

auf dem Desktop.

2 Klicken Sie auf der linken Seite auf das Symbol der gewünschten Datei.

■ Klicken Sie auf eines dieser Symbole, um den Dateityp der zu übertragenden Datei zu wählen.
steht für eine Musikdatei und für eine Bilddatei.

■ Klicken Sie auf das Symbol , um die ETC-Liste anzuzeigen. Die ETC-Liste enthält andere
Dateitypen (z. B. TXT, XOV, usw.), und keine Musik-, Bild- oder Videodateien.

3 Klicken Sie unten in Media Studio auf 
<Add Folder> (Ordner hinzufügen).
■ Das Fenster „Open Folder“ (Ordner öffnen) wird eingeblendet.

Bevor Sie beginnen ■ Schließen Sie den Player an Ihren PC an.
■ Stellen Sie sicher, dass Media Studio auf Ihrem PC installiert ist.

Ordner hinzufügen

3 Klicken Sie unten in Media Studio auf <Add File>
(Datei hinzufügen).
■ Das Fenster „Open“ (Öffnen) wird eingeblendet.

4 Wählen Sie die hinzuzufügenden Dateien aus, und
klicken Sie auf <Open> (Öffnen).
■ Die ausgewählten Dateien werden zu der Liste hinzugefügt, die

unter Media Studio auf der linken Seite angezeigt wird.

Dateien hinzufügen

4 Wählen Sie den hinzuzufügenden Ordner aus, und
klicken Sie auf <OK>.
■ Die Dateien des ausgewählten Ordners werden zu der Liste hinzugefügt,

die unter Media Studio auf der linken Seite angezeigt wird.

4

4
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Dateien mit Samsung Media Studio auf den Player übertragen
Dateien übertragen

HINWEISE

■   Das Verfahren zur Musikerkennung und damit verbundene Daten werden von Gracenote und
dem Gracenote CDDB® Music Recognition ServiceSM zur Verfügung gestellt.

■   CDDB ist ein eingetragenes Warenzeichen von Gracenote. Das Gracenote-Logo und der
Logotyp, das Gracenote-CDDB-Logo und der Logotyp sowie das Logo “Powered by Gracenote
CDDB” sind eingetragene Warenzeichen von Gracenote. Music Recognition Service und MRS
sind Service-Warenzeichen von Gracenote.

Folgen Sie den unten stehenden Anweisungen, um Dateien vom Computer auf
den Player zu übertragen.

4

3

2

Fenster 
<Portable> (Mobil)
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1 Media Studio startet automatisch, sobald Sie den Player an den PC anschließen.
■ Fall das Programm nicht automatisch startet, doppelklicken Sie auf das Media Studio-Symbol 

auf dem Desktop.

2 Klicken Sie auf der linken Seite auf das Symbol der gewünschten Datei.

■ Klicken Sie auf eines dieser Symbole, um den Dateityp der zu übertragenden Datei zu wählen.
steht für eine Musikdatei und für eine Bilddatei.

■ Klicken Sie auf das Symbol  , um die ETC-Liste anzuzeigen. Die ETC-Liste enthält andere
Dateitypen (z. B. TXT, XOV, usw.), und keine Musik-, Bild- oder Videodateien.

3 Wählen Sie die zu übertragende Datei in der linken Dateiliste aus.

■   Trennen Sie die USB-Verbindung nicht während der Übertragung. Dies kann zu Schäden am Player
und am PC führen.ACHTUNG

■   Bilddateien werden vor der Übertragung auf den Player mit <Media Studio> automatisch in das
JPG-Format konvertiert. Auch die Größe der Dateien wird automatisch angepasst.

■   Bilddateien, die nicht mit <Media Studio> auf den Player übertragen werden, werden auf dem
Bildschirm des Players möglicherweise anders angezeigt als im Original.

HINWEISE

4 Klicken Sie auf das Symbol .

■ Die ausgewählten Dateien werden auf den Player übertragen.

Bevor Sie beginnen ■ Schließen Sie den Player an Ihren PC an.
■ Stellen Sie sicher, dass Media Studio auf Ihrem PC installiert ist.
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Musik wiedergeben
Musik wiedergeben

Bevor Sie beginnen Schließen Sie den Ohrhörer an, schalten Sie den Player ein, und überprüfen 
Sie den Akku.

1 Berühren und halten Sie die Taste [ ], um das
Hauptmenü aufzurufen.

2 Wählen Sie mit [ ] die Option <Music>

(Musik) aus, und berühren Sie dann [ ].

■ Das Musikmenü wird geöffnet.

Musikmenü
■   <Now Playing> (Aktuelle Wiedergabe): Der aktuell

wiedergegebene Titel wird angezeigt.
■  <Artists> (Interpret): Wiedergabe nach Interpret
■  <Albums> (Album): Wiedergabe nach Album 
■  <Tracks> (Track): Wiedergabe der Titel in numerischer bzw.

alphabetischer Reihenfolge
■  <Genres> (Genre): Wiedergabe nach Musikgenre 
■  <Playlists> (WG-Liste): Wiedergabe der Wiedergabeliste 

HINWEISE

■   Der Player kann Musikdateien des Formats MP3 und WMA wiedergeben.
■   MP1- und MP2-Dateien, deren Dateierweiterung in MP3 geändert wurde, können nicht auf dem Player abgespielt werden.
■   Eine Datei ohne ID3-Marke (Titelinformationen) wird als <Unknown> (Unbekannt) angezeigt.
■   Dateien mit ID3-Marke werden im Player automatisch nach Interpret, Album usw. geordnet.

Eine ID3-Marke ist ein Bestandteil von Musikdateien und liefert Zusatzinformationen zum Titel.

3 Wählen Sie mit [ ] die Option <Artists>

(Interpret) aus, und berühren Sie dann [ ].

Beispiel: Wiedergabe nach Interpret

1

2,3

Music
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4 Wählen Sie mit [ ] einen Interpreten aus,

und berühren Sie dann [ ].
■   Es werden alle Alben des Interpreten angezeigt.

5 Wählen Sie mit [ ] ein Album aus, und

berühren Sie dann [ ].
■  Es werden alle Musikdateien des gewählten Albums

angezeigt.

6 Wählen SIe mit [ ] eine Musikdatei für die

Wiedergabe aus, und berühren Sie dann [ ].
■   Die Musikdatei wird abgespielt.

4,5,6

Music

Now Playing

Artists

Albums

Tracks

Genres

Playlists
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Musik wiedergeben (Fortsetzung)
Musik wiedergeben

Musikwiedergabe anhalten (Pausenmodus aktivieren)

1 Berühren Sie während der Musikwiedergabe die Taste [ ]. 
■   Die Musikwiedergabe wird angehalten.

2 Berühren Sie die Taste [ ] erneut. 
■  Die Musikwiedergabe wird an der Stelle fortgesetzt, an der sie angehalten wurde.

HINWEIS

■  Wenn im Pausemodus über einen voreingestellten Zeitraum (Standardeinstellung: 1 Minute) keine Tasten
betätigt werden, wird der Player automatisch ausgeschaltet. √ Siehe Seite 42

Titel durchsuchen

1 Berühren und halten Sie während der Wiedergabe des ausgewählten Titels eine
der Tasten [ ]. 
■  So können Sie den Titel in beide Richtungen durchsuchen.

2 Geben Sie die Taste an der Stelle frei, an der die Wiedergabe beginnen soll.
■  Die Wiedergabe beginnt an der Stelle, an der Sie die Taste freigeben.
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Aktuellen Titel von Anfang an abspielen

Berühren Sie die Taste [ ], nachdem der Titel 3 Sekunden lang abgespielt wurde. 

■  Der aktuelle Titel wird von Anfang an abgespielt.

Vorigen/nächsten Titel abspielen

Berühren Sie die Taste [ ] innerhalb der ersten 3 Sekunden der
Titelwiedergabe. 

■  Der vorherige Titel wird abgespielt.

Berühren Sie die Taste [ ].

■  Der nächste Titel wird abgespielt.

ACHTUNG

■   Wenn Sie VBR-Dateien (Dateien mit variabler Bitrate) abspielen, wird unter Umständen nicht der vorherige

Titel wiedergegeben, auch wenn Sie die Taste  [ ] vor Ablauf der ersten 3 Sekunden des Titels berühren.
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Wiedergabeliste mit Samsung Media Studio erstellen
Musik wiedergeben

1 Klicken Sie oben in Media Studio auf <My Album> (Eigenes Album).
■   Das Fenster <My Album> (Eigenes Album) wird geöffnet.

Eine Wiedergabeliste ist eine Liste mit von Ihnen ausgewählten Titeln.

2 Klicken Sie unten auf <New Album> (Neues Album).
■   Das Fenster <Creation> (Erstellen) wird geöffnet.

3 Geben Sie den Titel für das Album ein, und klicken Sie auf <OK>.
■   Es wird ein neues Album (eine neue Wiedergabeliste) erstellt und im Bereich <My Album>

(Eigenes Album) abgespeichert.

1

2

3
3
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Musikdateien in eine Wiedergabeliste aufnehmen

Wiedergabeliste mit Media Studio auf den Player übertragen

1 Klicken Sie oben in Media Studio auf <My PC>

(Eigener Computer).
■   Das Fenster <My PC> (Eigener Computer) wird

geöffnet.  

2 Klicken Sie rechts im Fenster auf <My Album>
(Eigenes Album).
■   Das Fenster <My Album> wird geöffnet.

3 Doppelklicken Sie auf das gewünschte Album
im rechten Fenster.

4 Wählen Sie im Fenster <My PC> (Eigener
Computer) die gewünschten Dateien aus.

1 Klicken Sie oben in Media Studio auf <My Album>

(Eigenes Album).
■   Das Fenster <My Album> (Eigenes Album) wird geöffnet.

2 Klicken Sie rechts im Fenster auf <Portable>
(Mobil).
■   Das Fenster <Portable> (Mobil) wird geöffnet.

3 Wählen Sie das gewünschte Album in der
Liste <My Album> (Eigenes Album) aus.

4 Klicken Sie auf das Symbol .
■   Das ausgewählte Album (die Wiedergabeliste) wird auf

den Player übertragen und unter <Music> ➝
<Playlists> (Musik ➝ WG-Liste) gespeichert.

5 Klicken Sie auf das Symbol .
■   Die ausgewählten Dateien werden zum Album (zur

Wiedergabeliste) hinzugefügt.

1

1

2

2

4

3
4

5
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Wiedergabeliste abspielen
Musik wiedergeben

Bevor Sie beginnen Weitere Informationen zur Erstellung von Wiedergabelisten sowie zu deren
Übertragung auf den Player finden Sie auf den Seiten 26-27.

1 Berühren und halten Sie die Taste [ ], um das Hauptmenü
aufzurufen.

2 Wählen Sie mit [ ] die Option <Music> (Musik) aus, und

berühren Sie dann [ ].

■ Das Musikmenü wird geöffnet.

3 Wählen Sie mit [ ] die Option <Playlists> (WG-Liste) aus,

und berühren Sie dann [ ].

■  Die Wiedergabeliste(n) wird/werden angezeigt.

■  Falls keine Wiedergabeliste vorhanden ist, wird die Meldung <No File>
(Keine Datei) im Bildschirm angezeigt.

4 Wählen Sie mit [ ] die gewünschte Wiedergabeliste aus,

und berühren Sie dann [ ].
■   Es werden alle in der gewählten Wiedergabeliste gespeicherten

Musikdateien angezeigt.

5 Wählen Sie mit [ ] eine Musikdatei für die Wiedergabe aus,

und berühren Sie dann [ ].
■   Die Musikdatei wird abgespielt.

Music

Now Playing

Artists

Albums

Tracks

Genres

Playlists
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Toneffekt auswählen

Grafik-Equalizer ein-/ausschalten

1 Berühren Sie die Taste [ ], während die Musik läuft.
■  Das Musikoptionen-Menü wird geöffnet.

Für die Musikwiedergabe können Sie zwischen verschiedenen Toneffekten wählen.

2 Wählen Sie mit [ ] die Option <Sound Effect> (Toneffekt)

aus, und berühren Sie dann [ ].

■  Das Toneffekt-Menü wird geöffnet.

3 Wählen Sie mit [ ] den gewünschten Toneffekt aus, und

berühren Sie dann [ ].

■  Wählen Sie zwischen <Normal>, <Vocal> (Vokal), <Bass Boost>
(Tiefen-Verstärk.), <3D Sound> (3D-Sound) und <Concert Hall>
(Konzertsaal).

1 Berühren Sie die Taste [ ], während die Musik läuft.
■  Das Musikoptionen-Menü wird geöffnet.

2 Wählen Sie mit [ ] die Option <Graphic EQ> (Grafik-

EQ) aus, und berühren Sie dann [ ].

■  Das Menü für den Grafik-Equalizer wird geöffnet.

3 Wählen Sie mit [ ] die Einstellung <On> (Ein) oder

<Off> (Aus), und berühren Sie dann [ ].

■  <On> (Ein): Der Grafik-Equalizer wird im Bildschirm angezeigt.
■  <Off> (Aus): Der Grafik-Equalizer wird nicht im Bildschirm angezeigt.

Musikoptionen einstellen
Musik wiedergeben

Sound Effect

Graphic EQ

Play Mode

Normal

Sound Effect

Graphic EQ

Play Mode

Normal
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Wiedergabemodus auswählen

1 Berühren Sie die Taste [ ], während die Musik läuft.

■  Das Musikoptionen-Menü wird geöffnet.

2 Wählen Sie mit [ ] die Option <Play Mode> (WG-Modus)

aus, und berühren Sie dann [ ].

■  Das Wiedergabemodus-Menü wird geöffnet.

3 Wählen Sie mit [ ] den gewünschten Modus aus, und

berühren Sie dann [ ].

■  Wählen Sie zwischen <Normal>, <Repeat One> (WH: 1 Titel), <Repeat>
(Wiederholen) und <Shuffle> (Zufall).

Musikoptionen einstellen (Fortsetzung)
Musik wiedergeben

■  <Normal> (Normal): Einmaliges Abspielen aller Titel in der Reihenfolge.
■  <Repeat One> (WH: 1 Titel): Einen Titel wiederholen.
■  <Repeat> (Wiederholen): Alle Titel wiederholen.
■  <Shuffle> (Zufall): Zufallswiedergabe. 

Sound Effect

Graphic EQ

Play Mode

Normal
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1 Berühren und halten Sie die Taste [ ], um
das Hauptmenü aufzurufen.

2 Wählen Sie mit [ ] die Option <Photo>

(Foto) aus, und berühren Sie dann [ ].

■ Die Bilderliste wird geöffnet.

3 Wählen Sie mit [ ] das gewünschte

Bild aus, und berühren Sie dann [ ].
■ Die gewünschte Datei wird angezeigt.
■ Große Bilder benötigen eine längere Ladezeit.

1 Berühren Sie die Taste [ ] im
Bildanzeigemodus.
■  Die Diashow wird gestartet

2 Berühren Sie die Taste [ ], um die Diashow
abzubrechen.

Diashow anzeigen

Berühren Sie eine der Tasten [ ].
■  Das vorherige bzw. das nächste Bild wird angezeigt.

Voriges bzw. nächstes Bild anzeigen
HINWEIS

■   Die Miniaturansicht für eine
Datei wird angezeigt,
sofern diese Datei über
eine solche Ansicht verfügt. 
Ansonsten wird
angezeigt.

Bilder anzeigen
Bilder anzeigen

Bevor Sie beginnen Infos zur Übertragung von Bilddateien auf den Player siehe Seite 20-21.

Sie können die Bilder in der Liste nacheinan-
der als Diashow anzeigen lassen.

1

2,3
1,2

Photo
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Ein Bild zur Bildschirmschoner-Liste hinzufügen

Während der Bildanzeige Musik wiedergeben

1 Wählen Sie die Bilddatei aus, die Sie in die Liste der
Bildschirmschoner aufnehmen möchten.

2 Berühren Sie [ ], während ein Bild angezeigt wird.

■   Das Bildoptionen-Menü wird geöffnet.

3 Wählen Sie mit [ ] die Option <Add to Screen Saver> 

(Zu BS-Schoner Hinzufügen) aus, und berühren Sie dann [ ].
■  Die ausgewählte Fotodatei wurde zur Bildschirmschonerliste hinzugefügt.

1 Berühren Sie [ ], während ein Bild angezeigt wird.

■   Das Bildoptionen-Menü wird geöffnet.

Sie können während der Bildanzeige den zuletzt wiedergegebenen Musiktitel abspielen.

2 Wählen Sie mit [ ] die Einstellung <Background Music On>
(Hintergrundmusik Ein) oder <Background Music Off>
(Hintergrundmusik Aus).

■  <Background Music On> (Hintergrundmusik Ein): Sie können während
der Bildanzeige den zuletzt gehörten Musiktitel wiedergeben.

■  <Background Music Off> (Hintergrundmusik Aus): Bei der Bildanzeige
wird keine Hintergrundmusik abgespielt.

Bildoptionen einstellen
Bilder anzeigen

HINWEISE

■   Wählen Sie unter <Settings> → <Display> → <Screen Saver> (Einstellg. →Display → BS-Schoner) die
Option <Photo> (Foto). Das ausgewählte Foto wird als Bildschirmschoner im Bildschirm angezeigt. 
√ Siehe Seite 41

■   Wenn Sie <Default Set> (Standardeinstellung) wählen, wird als Bildschirmschoner <Analog Clock>
(Analoguhr) angezeigt.

Background Mu..

Add to Screen S..

Background Mu..

Add to Screen S..
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UKW-Radio verwenden

UKW-Radio verwenden

Bevor Sie beginnen
Schließen Sie den Ohrhörer an, schalten Sie das Gerät ein, 
und überprüfen Sie den Akku.

1 Berühren und halten Sie die Taste [ ], 
um das Hauptmenü aufzurufen.

2 Wählen Sie mit [ ] die Option <FM Radio>

(UKW-Radio) aus, und berühren Sie dann [ ].

■  Der UKW-Radioempfang wird aktiviert.

Berühren Sie die Taste [ ], wenn das UKW-Radio
eingeschaltet ist.
■   Der Ton wird stumm geschaltet.

■   Drücken Sie die Taste [ ] erneut, um die Stummschaltung
aufzuheben.

Stummfunktion verwenden

■   Schließen Sie zur Sendersuche immer den Ohrhörer an den Player an. Der Ohrhörer dient
gleichzeitig als Antenne zum Radioempfang.ACHTUNG

1

2

FM Radio
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Modus für gespeicherte Sender aufrufen

Manuellen Sendereinstellmodus aufrufen

1 Berühren Sie im <Manual Mode> (Manueller Modus) die Taste [ ]
.

2 Wählen Sie mit [ ] die Option <Go to Preset Mode>
(Sendermodus aufrufen), und berühren Sie dann [ ].
■  Im Bildschirm wird die Meldung <Preset Mode> (Modus für gesp. Sender)

angezeigt.

3 Wählen Sie mit [ ] einen gespeicherten Sender aus.

■  Sobald die Meldung <Preset Mode> (Modus für gesp. Sender) im Bildschirm
angezeigt wird, können Sie einen Radiosender auswählen und Radio hören.

1 Berühren Sie im <Preset Mode> (Modus für gesp. Sender)
die Taste [ ], um das UKW-Optionsmenü aufzurufen.

2 Wählen Sie mit [ ] die Option <Go to Manual Mode>

(Man. Modus Aufrufen), und berühren Sie dann [ ].

■  Im Bildschirm wird die Meldung <Manual Mode> (Manueller
Modus) angezeigt.

HINWEISE

■   Falls noch kein Sender gespeichert wurde, erscheint die Meldung <Preset list does not exist>
(Senderliste nicht vorhanden), und der <Preset Mode> (Modus für gesp. Sender) kann nicht aktiviert
werden.

■   Wenn Sie <Default Set> (Standardeinstellung) wählen, werden alle angelegten Listen gelöscht.
■   Mit der Option <Preset List> (Sender Liste) im UKW-Optionsmenü können Sie die gespeicherten

Senderfrequenzen anzeigen.
■   Weitere Informationen zum Speichern von Sendern finden Sie auf Seite 36 bis 37.

UKW-Radio verwenden (Fortsetzung)
UKW-Radio verwenden

Wählen Sie diesen Modus, um eine Senderfrequenz im UKW-Bereich manuell
einzustellen.

Wählen Sie diesen Modus, um einen der bereits gespeicherten UKW-Sender aufzurufen.

Go to Manual ..

Delete Preset

Auto Preset

Preset List

FM Sensitivity

Preset Mode

Go to Preset ..

Add Preset

Auto Preset

FM Sensitivity

Manual Mode
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Sender manuell suchen

Sender automatisch suchen

Berühren und halten Sie eine der Tasten [ ] im <Manual
Mode> (Manueller Modus).

■  Es wird der Sender gesucht, der am nächsten an der Frequenzposition ist,

an der Sie die Taste wieder freigegeben haben.

Berühren Sie eine der Tasten [ ] im <Manual Mode>
(Manueller Modus).

■  Bei jedem Berühren der Taste wird die Senderfrequenz verringert oder erhöht.

Manual Mode

Manual Mode
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Sender automatisch speichern

1 Berühren Sie im Modus <FM Radio> (UKW-Radio) die Taste

[ ], um das UKW-Optionsmenü aufzurufen.

2 Wählen Sie mit [ ] die Option <Auto Preset>

(Autom. Sendersp.), und berühren Sie dann [ ].

■  Das Fenster <Auto Preset> (Automatische Voreinstellung) wird
angezeigt. Sie werden zur Bestätigung der Sendersuche
aufgefordert.

3 Wählen Sie mit [ ] die Einstellung <Yes> (Ja), und

berühren Sie dann [ ].

■  Der automatische Sendersuchlauf beginnt; es werden maximal 30
Sender gespeichert.

Sender einstellen
UKW-Radio verwenden

Im UKW-Radiomodus können Sie bis zu 30 Sender speichern.

Automatischen Sendersuchlauf abbrechen

Berühren Sie die Taste [ ], um die automatische Sendersuche abzubrechen.

■  Der Suchlauf wird abgebrochen und die bis dahin gefundenen Sender werden gespeichert.

■   Wenn Sie die Funktion <Auto Preset> (Autom. Sendersp.) erneut starten, werden alle bereits
gespeicherten Sender gelöscht.HINWEIS

Go to Preset ..

Add Preset

Auto Preset

FM Sensitivity

Manual Mode
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Sender im <Preset Mode> (Modus für gesp. Sender) aufrufen

1 Tippen Sie auf [ ], um den gewünschten Sender über
<Manual Mode> (Manueller Modus) auszuwählen.

2 Berühren Sie die Taste [ ].

3 Wählen Sie mit [ ] die Option <Add Preset> (Sender
Zufügen), und berühren Sie dann [ ].

■   Der eingestellte Sender wird zur Senderliste hinzugefügt.
In die Senderliste können bis zu 30 Sender eingetragen werden; die Liste
wird dabei nicht sortiert.

Berühren Sie eine der Tasten [ ] im <Preset Mode> (Modus
für gesp. Sender).

■  Bei jeder Tastenberührung wird der vorherige bzw. nächste gespeicherte
Sender aufgerufen und empfangen.

4 Führen Sie die oben beschriebenen Schritte 1-3 erneut durch,
um anderen Frequenzen Sendernummern zuzuweisen.

■   Falls der Sender, den Sie speichern möchten, bereits in der Liste vorhanden ist, erscheint die Meldung
<This preset already exists.> (Sender bereits vorhanden). Der eingestellte Sender wird dann nicht in die
Senderliste aufgenommen.HINWEIS

■   Wenn Sie die Senderliste im <Preset Mode> (Modus für gesp. Sender) überprüfen möchten,
berühren Sie die Taste [ ], wählen Sie <Preset List> (Sender Liste) und berühren Sie dann [ ].HINWEIS

Go to Preset ..

Add Preset

Auto Preset

FM Sensitivity

Manual Mode

Preset Mode
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1 Berühren Sie die Taste [ ] im <Preset Mode> (Modus für
gesp. Sender), um das UKW-Optionsmenü aufzurufen.

2 Wählen Sie mit [ ] die Option <Delete Preset> (Sender

Löschen), und berühren Sie dann [ ].

■  Die gespeicherten Senderfrequenzen werden angezeigt.

3 Wählen Sie mit [ ] den zu löschenden Sender aus, 

und berühren Sie dann [ ].
■   Ein Bestätigungsfenster wird geöffnet.

4 Wählen Sie mit [ ] die Option <Yes> (Ja), und berühren

Sie dann [ ].

■ Der ausgewählte Sender wird gelöscht.

5 Führen Sie die Schritte 1-4 erneut durch, um weitere Sender
auszuwählen und zu löschen.

Gespeicherte Sender löschen
UKW-Radio verwenden

89.1MHz

89.2MHz

89.3MHz

89.4MHz

Delete Preset
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UKW-Radio verwenden

UKW-Radio einstellen

UKW-Empfindlichkeit einstellen

1 Berühren Sie im Modus <FM Radio> (UKW-Radio) die Taste

[ ], um das UKW-Optionsmenü aufzurufen.

2 Wählen Sie mit [ ] die Option <FM Sensitivity> (UKW-

Empfindlichkeit), und berühren Sie dann [ ].

■  Das Menü zur Einstellung der UKW-Empfindlichkeit erscheint.

3 Stellen Sie mit [ ] die Empfindlichkeit ein, und berühren

Sie dann [ ].
■   Sie können dabei zwischen <High> (Hoch), <Middle> (Mittel) und 

<Low> (Niedrig) wählen.

■   Je höher die UKW-Empfindlichkeit, desto mehr Sender können Sie 
empfangen.

Go to Preset ..

Add Preset

Auto Preset

FM Sensitivity

Manual Mode
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Displayeinstellungen Sie können die Displayhelligkeit und die Zeit für das 
automatische Ausschalten des Bildschirmschoners 
einstellen.

Einstellungen

1 Berühren und halten Sie die Taste [ ], um das Hauptmenü
aufzurufen.

2 Wählen Sie mit [ ] die Option <Settings> (Einstellg.) aus,

und berühren Sie dann [ ].

■  Das Einstellungsmenü wird geöffnet.

3 Wählen Sie mit [ ] die Option <Display> (Display) aus, 

und berühren Sie dann [ ].

■  Das Menü für die Displayeinstellungen wird geöffnet.

4 Stellen Sie die gewünschten Optionen mit den Tasten [ ] 
und [ ] ein.

Verwendung der Tasten bei der Einstellung
■   Mit [ ] gehen Sie Schritt für Schritt nach oben oder unten.

■   Berühren Sie [ ], um Einstellungen auszuwählen und zu bestätigen.

■   Mit der Taste [ ] gelangen Sie zum vorangegangenen Bildschirm.

HINWEIS

Display

Time

Language

System

Settings

Settings
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■ <Screen Saver> (BS-Schoner): Sie können ein Bild für den Bildschirmschoner auswählen.
Wählen Sie zwischen folgenden Optionen: <Analog Clock> (Analoguhr), <Animation1>
(Animation1), <Animation2> (Animation2), <Animation3> (Animation3) und <Photo> (Foto), und
stellen Sie die Zeit bis zur Aktivierung des Bildschirmschoners ein. Unter der Option <Photo>
(Foto) steht das Bild zur Verfügung, das Sie mit der Funktion <Add to Screen Saver> (Zu 
BS-Schoner Hinzufügen) zum Bildschirmschoner hinzugefügt haben. 
√ Siehe Seite 32
Wählen Sie zwischen folgenden Zeitoptionen: <10sec> (10Sek.), <30sec> (30Sek.), <1min>
(1Min), <3min> (3Min), <5min> (5Min) und <Off> (Aus). Wenn im gewählten Zeitraum keine Taste
betätigt wird, aktiviert das System den Bildschirmschoner.

■  <Display Off> (Display aus): Wenn über einen bestimmten Zeitraum keine Taste betätigt wird,
schaltet sich das Display automatisch aus.
Wählen Sie zwischen folgenden Zeitoptionen: <10sec> (10Sek.), <30sec> (30Sek.), <1min>
(1Min), <3min> (3Min), <5min> (5Min) und <Always On> (Immer an).
Drücken Sie eine beliebige Taste, um den Bildschirm wieder einzuschalten.

Einstellungen des Bildschirmschoners

1 Wählen Sie mit [ ] die Option <Screen Saver> 

(BS-Schoner), und berühren Sie dann [ ].
■  Das Bildschirmschoner-Menü wird geöffnet.

2 Wählen Sie mit [ ] den gewünschten Bildschirmschoner

aus, und berühren Sie dann [ ].

3 Wählen Sie mit [ ] eine Zeit bis zur Aktivierung des

Bildschirmschoners. Berühren Sie dann [ ].
■   Ein Bestätigungsfenster wird geöffnet.

4 Wählen Sie mit [ ] die Option <Yes> (Ja), und berühren

Sie dann [ ].
■  Die Einstellung des Bildschirmschoners ist abgeschlossen.

Photo

15 sec

Screen Saver
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Zeiteinstellungen Neben der aktuellen Uhrzeit können Sie auch die Funktionen
<Sleep Timer> (Sleep-Timer) und <Auto Power Off> (Autom.
Ausschalten) einstellen.

Einstellungen

1 Berühren und halten Sie die Taste [ ], um das Hauptmenü
aufzurufen.

2 Wählen Sie mit [ ] die Option <Settings> (Einstellg.) aus,

und berühren Sie dann [ ].

■  Das Einstellungsmenü wird geöffnet.

3 Wählen Sie mit [ ] die Option <Time> (Zeiteinst.) aus, und

berühren Sie dann [ ].

■  Das Menü für die Zeiteinstellungen wird geöffnet.

4 Stellen Sie die gewünschten Funktionen mit den Tasten [ ]
und [ ] ein.

■  <Sleep Timer> (Sleep-Timer): Schaltet das Gerät nach einer vorgegebenen
Zeit automatisch ab.
Wählen Sie zwischen folgenden Zeitoptionen: <Off> (Aus), <15 min> (15Min),
<30 min> (30Min) oder <60 min> (60Min).

■  <Auto Power Off> (Autom. Ausschalten): Schaltet das Gerät automa-
tisch ab, wenn über einen längeren Zeitraum keine Taste betätigt wurde
oder sich der Player im Pausenmodus befindet. Wählen Sie zwischen fol-
genden Zeitoptionen: <10 sec> (10Sek.), <30 sec> (30 Sekunden), <1 min>
(1Min), <5 min> (5Min) oder <10 min> (10Min).

■  <Time Set> (Zeit einstellen): Hier können Sie die aktuelle Uhrzeit ein-
stellen. √ Siehe Seite 43

Display

Time

Language

System

Settings
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Zeit einstellen

1 Wählen Sie mit [ ] die Option <Time Set> (Zeit Einstellen),

und berühren Sie dann [ ].

2 Drücken Sie auf [ ], um <AM/PM, Hour, Minute> (AM/PM,
Stunde, Minute) auszuwählen und auf [ ], um die Zeit
einzustellen.

3 Berühren Sie die Taste [ ].

■   Ein Bestätigungsfenster wird geöffnet.

4 Wählen Sie mit [ ] die Option <Yes> (Ja), und berühren

Sie dann [ ].
■  Die Zeiteinstellung wird gespeichert.

Hour         Min

PM 06          35

Time Set
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Sprache einstellen Sie können die Menüsprache auswählen.

Einstellungen

1 Berühren und halten Sie die Taste [ ], um das Hauptmenü
aufzurufen.

2 Wählen Sie mit [ ] die Option <Settings> (Einstellg.) aus,

und berühren Sie dann [ ].

■  Das Einstellungsmenü wird geöffnet.

3 Wählen Sie mit [ ] die Option <Language> (Sprache

(Language)), und berühren Sie dann [ ].

4 Wählen Sie die Menüsprache mit Hilfe der Tasten [ ] 
und [ ] aus.

■  Verfügbare Sprachen: <English>, < >, <Français>, <Deutsch>,

<Italiano>, < >, < >, < >,  <Español>, < >,
<Magyar>, <Nederlands>, <Polski>, <Português> und <Svenska>.

■   Unterstützte Sprachen können sich ändern und es können neue hinzugefügt werden.
HINWEISE

Display

Time

Language

System

Settings
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Systemeinstellungen Sie können verschiedene Optionen für das System 
einstellen.

Einstellungen

1 Berühren und halten Sie die Taste [ ], um das Hauptmenü
aufzurufen.

2 Wählen Sie mit [ ] die Option <Settings> (Einstellg.) aus,

und berühren Sie dann [ ].

■  Das Einstellungsmenü wird geöffnet.

3 Wählen Sie mit [ ] die Option <System> aus, und

berühren Sie dann [ ].

■  Das Menü für die Systemeinstellungen wird geöffnet.

4 Stellen Sie die gewünschten Funktionen mit den Tasten [ ]
und [ ] ein.

■   Frequenzbereich nach Region
- Korea/USA: Suche nach Sendern im Bereich von 87,5 MHz bis 108,0 MHz in Schritten von 100 kHz.
- Japan: Suche nach Sendern im Bereich von 76,0 MHz bis 108,0 MHz in Schritten von 100 kHz.
- Andere Länder: Suche nach Sendern im Bereich von 87,50 MHz bis 108,00 MHz in Schritten von 50 kHz..

■   Der UKW-Bereich kann je nach Aufenthaltsort geändert werden.
■   Wenn Sie den UKW-Bereich ändern, werden alle gespeicherten Radiosender gelöscht.

HINWEISE

■ <Resume> (Weiter): Sie können den Startpunkt festlegen, von dem aus die Wiedergabe 
fortgesetzt werden soll, nachdem die Musikwiedergabe gestoppt wurde. Bei der Option <On>
(Ein) wird die Musikwiedergabe an der Stelle fortgesetzt, an der sie angehalten wurde, bei der
Option <Off> (Aus) dagegen am Anfang des zuletzt abgespielten Titels.

■  <Beep> (Signalton): Aktiviert die Tastentöne. Wählen Sie zwischen <On> (Ein) oder <Off> (Aus).

■ <Volume Limit> (Lautstärkelimit): Um Hörschäden zu vermeiden, stellen Sie einen Höchstwert
für die Lautstärke ein, wenn Sie den Ohrhörer verwenden. Bei der Option <On> (Ein) ist die
Maximallautstärke auf 20 begrenzt, bei <Off> (Aus) auf 30.

■ <FM Region> (UKW-Bereich): Legen Sie den Bereich für das UKW-Radio fest. Sie können 
zwischen <Korea/USA> <Japan> , und <Other Countries> (Andere Länder) wählen.

Display

Time

Language

System

Settings



46

Rücksetzen

1 Wählen Sie mit [ ] die Option <Default Set> (Rücksetzen)

aus, und berühren Sie dann [ ].

■  Ein Bestätigungsfenster wird geöffnet.

2 Wählen Sie mit [ ] die Option <Yes> (Ja), und berühren Sie

dann [ ].
■   <Yes> (Ja): Alle Einstellungen werden auf den Standardwert zurückgesetzt.

■   <No> (Nein): Kein Rücksetzen auf die Standardeinstellungen.

Systemeinstellungen (Fortsetzung)
Einstellungen

■   <Default Set> (Rücksetzen): Setzt alle Werte auf die Standardeinstellung zurück.

■ <About> (Info): Sie können sich die Firmware-Version, die Speicherkapazität und die Anzahl der
Dateien anzeigen lassen.

■ <Firmware Version> (Firmware-Version): Gibt die derzeit verwendete Version der Firmware an.
■ <Memory> (Speicher): Zeigt Informationen zum Speicher an. <Used> (Belegt) bezeichnet den bereits
belegten Speicherplatz, <Remain> (Verbleibend) zeigt die verbleibende Kapazität, und <Total> (Gesamt)
entspricht der Gesamtspeicherkapazität.

■ <Files> (Dateien): <Music> (Musik) bezeichnet die Anzahl der Musikdateien, <Photo> (Foto) zeigt die
Anzahl der Fotos, und <Total> (Gesamt) entspricht der Gesamtanzahl an Dateien.

■   Wenn Sie <Default Set> (Standardeinstellung) wählen, werden alle vorgenommenen Einstellungen
gelöscht und auf die Standardwerte zurückgesetzt.

■   Hinweis zum eingebauten Speicher
Der verfügbare Speicher ist etwas geringer als der angegebene Speicherplatz, da die Firmware des
Players einen Teil des Speicherplatzes in Anspruch nimmt.

HINWEISE

Resume

Beep

Volume Limit

FM Region

Default Set

About

Settings
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Fehlersuche Ziehen Sie beim Auftreten eines Fehlers die unten stehende Tabelle zu Rate.
Besteht das Problem weiterhin, wenden Sie sich an den Kundendienst von
Samsung.

Das Gerät lässt sich
nicht einschalten

Die Tasten 
funktionieren nicht

Das Display lässt sich
nicht einschalten

Das Gerät schaltet
sich aus

Problem Möglicher Fehler und Gegenmaßnahmen

■  Überprüfen Sie, ob die Tastensperre aktiv ist (Sperrschalter 
[HOLD √] in Sperrposition).

■  Überprüfen Sie, ob Sie die richtige Taste gedrückt haben.
Drücken Sie die Taste erneut. √ Siehe Seite 11

■  Drücken Sie die Reset-Taste, um den Player zurückzusetzen.

■  Wenn Sie unter <Settings> (Einstellg.) → <Display> (Display) für die Einstellung
<Display Off> (Display aus) einen Zeitwert gewählt haben, hat sich das Display
eventuell ausgeschaltet. Drücken Sie eine beliebige Taste, um das Display
wieder einzuschalten und die Einstellungen zu überprüfen. √ Siehe Seite 41

■  Das Display ist bei direkter Sonneneinstrahlung möglicherweise nicht ablesbar.

■  Überprüfen Sie den Akkustatus.
■  Bei vollständig entladenem Akku schaltet sich das Gerät aus. Laden Sie den Akku auf.
■  Das Gerät wird im Pausemodus ausgeschaltet, wenn Sie unter <Settings>

(Einstellungen) → <Time> (Zeit) die Option <Auto Power Off> (Automatisches
Ausschalten) auswählen. Schalten Sie den Player ein.

Die Betriebszeit des
Akkus weicht von den
Angaben im Handbuch
ab

■  Die Betriebszeit des Akkus ist u.a. abhängig vom Tonmodus und von der
Displayeinstellung.

■  Wenn der Akku über einen längeren Zeitraum sehr hohen oder niedrigen
Temperaturen ausgesetzt ist, kann sich seine Lebensdauer verkürzen.

Fehlfunktion des
Programms

Verbindung mit dem PC
ist nicht möglich

Überprüfen Sie, ob die PC-Voraussetzungen erfüllt sind.

Klicken Sie in der Symbolleiste Ihres PCs auf <Start>, um das
Windows Update zu starten.
Wählen Sie die gewünschten Updates und Service Packs aus, und
starten Sie die Aktualisierung.
Starten Sie den PC neu, und stellen Sie die Verbindung wieder her.

■  Der Player lässt sich nicht anschalten, wenn der Akku 
vollständig entladen ist. Laden Sie den Akku auf, und schalten
Sie das Gerät erneut ein.

■  Drücken Sie die Reset-Taste, um den Player zurückzusetzen.
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Der Player wird heiß.
Während des Ladevorgangs kann es zu Wärmeentwicklung 
kommen. Dies hat keine Auswirkungen auf die Lebensdauer oder
die Funktionen des Geräts.

Die Wiedergabe ist
nicht möglich

Es können keine
Dateien übertragen
werden

Es fehlen Dateien bzw.
Daten

Ungewöhnliche
Zeitangabe während der
Wiedergabe

Problem Möglicher Fehler und Gegenmaßnahmen

■   Überprüfen Sie, ob die entsprechende Datei im Player gespe-
ichert wurde.

■   Überprüfen Sie, ob die gewählte Musikdatei beschädigt ist.
■   Überprüfen Sie, ob der Akku ausreichend geladen ist.

■   Überprüfen Sie, ob das USB-Kabel richtig angeschlossen ist.
Schließen Sie es gegebenenfalls noch einmal an.

■   Überprüfen Sie, ob der Speicher voll ist.
■   Drücken Sie die Reset-Taste, um den Player zurückzusetzen.

Überprüfen Sie, ob sich das USB-Kabel gelockert hat. Wenn dies
der Fall ist, kann es zu schweren Schäden an Dateien/Daten und
am Player führen. Bitte achten Sie darauf, dass dies nicht passieren
kann; Samsung kann für Datenverlust nicht verantwortlich gemacht
werden.

Überprüfen Sie, ob die Datei im VBR-Format (Variable Bitrate) 
vorliegt. In diesem Fall wird die Wiedergabezeit eventuell nicht 
korrekt angegeben.

Fehlersuche (Fortsetzung)
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Menü-Bildschirm

»≠∏È º≥¡§Display

Music
(Musik)

FM Radio
(UKW-Radio)

Photo
(Foto)

Alarm
(Alarm)

Settings
(Einstellg.)

BS-Schoner

Display aus

Zeiteinst.

Sleep-Timer

Autom. Ausschalten

Zeit Einstellen

Sprache (Language) System

Weiter

Signalton

Lautstärkelimit

UKW-Bereich

Rücksetzen

Info

Menü-Übersicht Hier können Sie sich einen Überblick über die Menüstruktur verschaffen.
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Technische Daten

Modellname

Stromversorgung

Kapazität des integrierten Akkus

Kompatible
Dateiformate

Ausgangsleistung Ohrhöreranschluss

Frequenzbereich

Rauschabstand

Betriebsdauer

Umgebungstemperatur bei Betrieb

Gehäuse

Gewicht

Abmessungen (BxHxT)

UKW-Frequenz

UKW-Signal/Rausch-Abstand

Gesamtklirrfaktor UKW

Nutzbare UKW-Empfindlichkeit

YP-K3

3,7 V (Lithium-Polymer-Akku, wiederaufladbar)

500 mAh

Musik: MPEG1/2/2.5 Layer3 (8 kBit/s ~ 320 kBit/s, 
WMA (8 kBit/s ~ 192 kBit/s, 8 kHz ~ 48 kHz)

Bilder: JPEG (ISO/IEC 10918-1/Anhang F - Sequentieller 
Betriebsmodus auf DCT-Basis)

20 mW (Frankreich: 5 mW/Kanal) (16 Ω)

20 Hz ~ 20 kHz

88 dB bei 20 kHz LPF (1 kHz, 0 dB)

25 Stunden Musikwiedergabe (bei MP3 128 kbit/s, Lautstärke 15, Normalmodus)

-5 ~ 35 °C

Edelstahl, Kunststoff

50 g

44 x 96 x 6,95 mm

87,5 ~ 108,0 MHz

50 dB

1 %

38 dBµ

● Der Inhalt dieses Handbuchs kann aufgrund von Weiterentwicklung ohne vorherige
Ankündigung geändert werden.
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Die Kennzeichnung auf dem Produkt bzw. auf der 
dazugehörigen Dokumentation gibt an, dass es nach seiner
Lebensdauer nicht zusammen mit dem normalen Haushaltsmüll
entsorgt werden darf. Entsorgen Sie dieses Gerät bitte 
getrennt von anderen Abfällen, um der Umwelt bzw. der
menschlichen Gesundheit nicht durch unkontrollierte
Müllbeseitigung zu schaden. Recyceln Sie das Gerät, um
die nachhaltige Wiederverwertung von stofflichen
Ressourcen zu fördern.
Private Nutzer wenden sich an den Händler, bei dem das
Produkt gekauft wurde, oder kontaktieren die zuständigen
Behörden, um in Erfahrung zu bringen, wie sie das Gerät auf
umweltfreundliche Weise recyceln können. Gewerbliche Nutzer
wenden sich an ihren Lieferanten und gehen nach den
Bedingungen des Verkaufsvertrags vor. Dieses Produkt darf nicht
zusammen mit anderem Gewerbemüll entsorgt werden.

Entsorgung von Altgeräten

Das Gerät, zu dem dieses Benutzerhandbuch gehört unterliegt den Bestimmungen 
zum geistigen Eigentum dritter Personen (Urheberrechtsschutz). Die Lizenz beschränkt
sich auf die private, nichtkommerzielle Nutzung durch Endverbraucher im
Zusammenhang mit lizenzierten Inhalten. Es sind keinerlei Rechte für die kommerzielle
Nutzung erteilt.
Die Lizenz erstreckt sich lediglich auf dieses Gerät und deckt keine unlizenzierten
Produkte oder Prozesse gem. ISO/IEC 11172-3 oder ISO/IEC 13818-3, die mit diesem
Gerät verkauft oder durchgeführt werden. Die Lizenz erstreckt sich lediglich auf die
Verwendung dieses Gerätes zum Kodieren/Dekodieren von Musik-/Videodateien gem.
SO/IEC 11172-3 oder ISO/IEC 13818-3.
Im Rahmen der Lizenz werden keine Rechte für Produktmerkmale oder Funktionen
gewährt, die nicht der ISO/IEC 11172-3 oder ISO/IEC 13818-3 entsprechen.

Technische Daten
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Falls Sie Fragen oder Anregungen zu Samsung-Produkten haben, 
wenden Sie sich bitte an den Samsung-Kundendienst.

Samsung Electronics GmbH 
Hotline: 01805 - 121213 (€ 0,12/Min. aus Festnetz/DTAG) 

www.samsung.de


